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Imagine the phone rings, and before you even pick
up, the patient’s Dentrix information is instantly on
your screen. Access to appointments, treatments,
prescriptions and balances for the whole family are
right at your fingertips. That’s OfficeSuite Dental,
the only personalized patient dashboard and
phone system that fully integrates with Dentrix
G5. Combining these powerful tools allows your
team to work more efficiently, be more profitable
and provide a more positive customer experience.
Find out how OfficeSuite Dental + Dentrix G5 can
answer the call to enhance patient interaction.
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Every year, hundreds of thousands of dental professionals attend
industry conferences and association meetings. They listen to
speeches, attend courses, and visit with vendors in search of ideas to
build a better practice. Sometimes all it takes is one idea—one spark—
to ignite improvement and put your practice on the path to growth.
To help spark improvements in your practice, this issue of Dentrix
Magazine includes highlights from the 2014 Dentrix Business of
Dentistry Conference. In our cover story, “Top Tips from the 2014
Dentrix Business of Dentistry Conference” (page 12), we summarize
practice management guidance from several conference speakers.
These industry experts provide suggestions to help you boost
insurance reimbursement, increase treatment case acceptance,
schedule with less stress and greater profitability, incorporate sameday dentistry in your practice, create a dream team, and more. We
also reviewed hundreds of attendee surveys and identified the
Dentrix tips and tricks they found most helpful. You’ll find them in the
Dentrix Tips & Tricks column beginning on page 8.
If you attended this year’s conference, thank you for joining us.
If you weren’t able to attend, I hope reading this issue of Dentrix
Magazine will inspire you to join us next year when we convene the
2015 Dentrix Business of Dentistry Conference at Gaylord Palms
Resort & Convention Center in Kissimmee, Florida on October 7-10.
Put it on your calendar today and visit www.Dentrix.com/BDC2015
for updates.
I hope you enjoy reading Dentrix Magazine. Please consult the
reading guide on page 2 to find the articles that correspond to your
responsibilities in the dental practice. And remember, every issue of
Dentrix Magazine is available online at www.Dentrix.com/Magazine.
Download yours today.
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Reading Guide
The Dentrix Mastery Tracks program is comprised of topics and tracks that align with
key job functions in your practice. Whether you are preparing for a Dentrix Mastery
Tracks test or just want to improve your skills, use this reading guide to find the
articles in this issue of the magazine that match your responsibilities in your practice.
Visit www.Dentrix.com/Mastery to learn more about Dentrix Mastery Tracks.

Clinical
Charting
Treatment Planning

Viewing All of a Patient’s Clinical Notes in One List, page 10
Modifying Patient-Friendly Descriptions, page 11

Financial
Billing & Accounts
Receivable
Insurance

Using the Collections Manager to Target Specific Accounts, page 8
Understand Your Patient Accounts Better with Dentrix Billing Types, page 20
Setting up Custom Claim Remark Templates, page 11

Front Office
Continuing Care
Patient Information
Scheduling

Assign a Default Provider to a Continuing Care Type, page 9
Assign a Default Provider to a Continuing Care Type, page 9
Understand Your Patient Accounts Better with Dentrix Billing Types, page 20
Generating the Scheduled Patient Summary, page 10
Manage Your Complex Office Schedule Within Dentrix, page 18

Practice Analysis
Practice Analysis
& Security

Viewing Past Practice Advisor Reports, page 11

How To Learn More
If you want to learn more about the Dentrix topics featured in Dentrix Magazine, check out these self-paced learning resources.
Dentrix Help Files
Dentrix Resource Center
In the Dentrix Help Files, you can explore a comprehensive
The Dentrix Resource Center includes the Dentrix
list of conveniently indexed topics or search the topics for key
Mastery Tracks Learning Plans. It also offers an online library
words. To search the Help files, from the Help menu in any
of on-demand software training videos, downloadable
product manuals, and a knowledgebase of technical support
Dentrix Module, click Contents, click the Search tab, type a
articles. Access is free for dental practices on a Dentrix
search phrase or topic name, click List Topics, and then under
Customer Service Plan. Log in today at www.Dentrix.com/
Select Topic, double-click the topic name. Tip: To turn off the
Resource-Center.
search highlights, press F5.
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Is Your Team Ready
for Your Success?
Add value to your Dentrix solution by
empowering the people who use it.
Dentrix Mastery Tracks will make sure every member of your
team is as prepared and capable as your technology—by giving
you a fast and affordable way to test what they know about
Dentrix and find out where they need improvement. It also
directs them to the targeted training they need to enhance
their skills and improve your practice.

To get started, visit Dentrix.com/Mastery

Dentrix News
Announcing Dentrix Mastery Tracks

In October 2014, Henry Schein launched the Dentrix
Mastery Tracks™ program. Mastery Tracks provides a fast,
affordable way to find out how well Dentrix professionals
understand and can utilize all the capabilities in Dentrix,
quickly identify areas where their knowledge is lacking, and
then provide the targeted training they need to improve
their skills.
Dentrix Mastery Tracks is made up of four tracks, each
featuring one or more tests that align with specific job functions and responsibilities in a dental practice. Users can test
their Dentrix skills in scheduling, continuing care, billing and
accounts receivable, insurance, charting, treatment planning,
reporting and security, and patient information. After successfully completing each test, users receive a skill certificate
acknowledging their competence. When users successfully

complete all required tests for a specific Mastery Track, they
receive an official Dentrix Specialist certificate to signify their
competence in that practice management area.
“With Dentrix Mastery Tracks, dental practitioners can
be more confident in their team members’ correct use of the
full range of Dentrix features for operating a more efficient
and productive practice,” said Kevin Bunker, President, Henry
Schein North America Dental Practice Solutions. “Delivering
training and skill assessment for office staff is another example
of our commitment to helping our Dentrix users better manage
their practices, so dentists can focus on providing healthcare.”
To help users strengthen their skills, Dentrix Mastery Tracks
offers a complete range of online and in-person Dentrix
learning options, including test blueprints, hands-on workshop training, in-office training, an online resource center for
self-paced training, and other publications, such as Dentrix
Magazine and the Dentrix eNewsletter. These tools can help
team members prepare for tests and fill any knowledge gaps
that become apparent after completing tests.
To create an account, select tracks, and take tests, visit
www.Dentrix.com/Mastery. Downloadable test guides, FAQs,
and a video overview are also available on that page.

PowerPay 5.0.2 Provides Windows 8/8.1 Compatibility
and New Devices

PowerPay is integrated credit card processing software that
reduces aging balances by allowing offices to secure payment
consents while patients are still in the office. And now, PowerPay
provides new compatibility for Windows 8/8.1 users and integration with an encrypted magstripe reader.
Until now, customers moving to Windows 8/8.1 were limited
to PowerPay LE for their integrated payment processing.
PowerPay 5.0.2 changes that by providing Windows 8/8.1 users
with the full version of PowerPay. Now offices on Windows 8/8.1
can collect after-insurance and recurring payment consents,
process pin-based debit transactions (when combined with the
appropriate hardware) and close-out the month using robust
transaction reporting.
Another benefit of PowerPay 5.0.2 is the integration with
the SecureKey™ M130 encrypted magstripe reader. Unlike
simple magstripe readers, this optional upgrade provides
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encryption at the device to ensure patient credit card data is
transmitted securely.
The SecureKey™ M130 is equipped with a magstripe reader
and keypad so that card payments can be processed with a
swipe or by manually entering the card number. The card data is
automatically encrypted using TDES/AES encryption algorithms
prior to transmission.
The end-to-end encryption technology not only reduces
the threat of data compromise, but also reduces the scope for
demonstrating Payment Card Industry Data Security Standards
(PCI DSS) compliance.
In addition to the encrypted card swipe reader, PowerPay
now integrates with the Ingenico ISC250. The ISC250 allows
PowerPay customers to process pin-based debit card transactions and collect electronic signatures.
PowerPay 5.0.2 is available through a download by
contacting eServices Support at 800-734-5561, option 1.
PowerPay and the encrypted magstripe reader can be
purchased by calling the same phone number, but pressing
option 2 to reach the eServices Account Executive team.
For more information about PowerPay, visit
www.Dentrix.com/PowerPay.

Office Technology To Power
Your Digital Practice

Computers

Networks

Security

Wi-Fi

Phones

Reliable computers
for digital dentistry

Professional,
networking and
installation

Network security
solutions to protect
your practice

Secure, fast Wi-Fi
for your business
and patients

Affordable,
cloud-based
phone systems

TechCentral Computer Support Plans
•
•
•
•

Unlimited support calls
Remote problem resolution
Secure server monitoring
On-site support when needed

Call 877.483.0382 or visit
www.HenryScheinTechCentral.com
Available exclusively from

©2014 Henry Schein Inc. Third-party products, logos, trademarks or registered trademarks are the property of their respective owners. See TechCentral Support Plan contract for details. A-TCDTXMAG-Q214

Product Management
Dentrix G6 Beta Update
Learn about more of the new features and enhancements in Dentrix G6 beta and
how you can participate in the beta program.

Brad Royer | Dentrix Product Manager

O

ver the last few months, I have
received some inquiries about
how the Dentrix G6 beta is
going. I am pleased to say that we have
received a lot of great feedback from
our beta customers. The comments
from the group have generally been
very positive. One customer stated,
“Overall this has been the best upgrade
yet. G6 is much more user friendly and
more visually pleasing . . . than the past
versions.” Others shared this sentiment
when they wrote, “I would say that our
satisfaction with G6 is high” and “We
are really enjoying G6.”

Figure 1 New fields were added for mobile
phone number and email address.

In our last issue of Dentrix Magazine
I described some of the top new
features in Dentrix G6. Since then we
have added a few more. These newest
enhancements, along with other
improvements requested by our beta
customers, were released in a beta 3
version in November.
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Some of the most exciting
additions we made for beta 3
were in the Appointment
Book. The Dentrix MyVoice
request to add more options
and customizations to the
Appointment Book view has,
in large part, been fulfilled.
The Appointment Book shows
more information on the
appointment, such as mobile
phone number and email
address. Options were also
added to display the patient’s
age, chart number, referral
source, primary insurance
plan, appointment status, and
any continuing care attached
to the appointment. We have
also added new fields in the
Figure 2 The time of the selected appointment is
Appointment Book’s Enter
highlighted on the time bar.
New Patient Information
dialog box where you can
now specify a mobile phone
on which computers when closing out
number and email address (Figure 1).
the month. And this is all just the tip of
Also, the time bar now appears
the iceberg. For more information about
highlighted for the time of the selected
what’s coming in Dentrix G6, visit our
appointment, making it easier to see
website at www.dentrix.com/products/
the exact time of scheduled
dentrix/whats-new.
appointments (Figure 2). In addition,
As we continue the beta process,
when you rest your mouse pointer over
we would love to receive feedback from
each provider color bar on the side of
more of you. If you are interested in
the Appointment Book, the software
participating in the Dentrix G6 beta,
now displays a tooltip that identifies
please send us an email request at
the associated provider. A new option
beta.dentrix@henryshein.com. As a
also allows you to hide the providers’
beta customer you have the ability to
color bars.
influence the product development
Of course new features aren’t
and refine the new features before they
limited to the Appointment Book. Perio
release in the final version.
records, just like Ledger transactions,
will now move into history as part of the
Brad Royer, the Dentrix product manager,
has eight years of experience working with
month-end process. This will ensure
Dentrix and other practice management
that previous Perio exams cannot be
products from Henry Schein. Brad can be
changed. We have also made it easier to
reached at brad.royer@henryschein.com.
see which Dentrix modules are still open

Digital Impressions
Electronic Services

Cone Beam CT

EXCLUSIVE PARTNER

Digital Panoramic X-rays

CAD/CAM Technology

EXCLUSIVE PARTNER

From the Front Office to the Treatment Room and every touch-point
in between, Henry Schein has the solutions you need to connect
your practice technologies. The size of your practice, your budget,
and your patients’ needs are all important to the solutions required
to increase workflow and enhance efficiency.
With your success in mind, let us help you determine which products
and technologies will advance patient care and your practice.

Digital Sensors

Contact your Henry Schein Sales Consultant for details.
EXCLUSIVE PARTNER

Finished Restoration
Intraoral Cameras

EXCLUSIVE PARTNER

EXCLUSIVE PARTNER

1-800-890-8153
www.henryscheindental.com

SPECIAL
EDITION

Tips

&Tricks
The tips in this special, extended version of Tips & Tricks come from Dentrix courses taught at the 2014 Business of
Dentistry Conference. This year’s conference featured more Dentrix topics than ever before, and these are the tips
our attendees rated as most helpful. Find the tips that correspond to your role in the practice, and try them out today!

Using the Collections Manager to Target Specific Accounts
from Maximizing Collections with Dentrix

The Collections Manager gives you the flexibility to set view filters to target the accounts on which you want to focus your
collections efforts. By understanding how these filters work, you can create a list of accounts that you can then begin to contact.
To open the Collections Manager, from the Office Manager, click Analysis > Collections Manager or click the Collections Manager
button. The Collections Manager View dialog box appears, allowing you to specify the filters you want to use to find specific patients.
Use the list below to learn what each filter does and decide which filters you want to use to create your Collections Manager List.

FILTER NAME

DESCRIPTION

SPECIAL NOTES

Allows you to filter the list by guarantor last name.

You can use alphabetical ranges to
manage a long list.

Select Billing Type

Allows you to filter the list by Billing Type.

You can select multiple types by holding
the CTRL button while selecting types.

Skip Accounts With Claim
Pending

Allows you to exclude accounts with insurance claims outstanding.

You can enter a minimum patient
portion amount to include accounts with
insurance outstanding, but who owe a
significant portion of their balance.

Select # of Payments
Missed

Allows you to filter the list by the number of missed payments on a
payment agreement.

This filter only applies to accounts with a
payment agreement set up.

Minimum Days Past Due

Allows you to filter the list by the age of the account.

Only accounts with a balance in the
specified aging bracket will be included.

Select Provider

Allows you to filter the list by assigned provider.

References the guarantor’s assigned
provider in the Family File.

Minimum Balance

Allows you to filter the list by the balance on the account.

Last Payment Before

Allows you to exclude patients who have made a payment since a
specified date.

If Not Billed Since

Allows you to exclude patients who have received a recent bill.

Last Visit Before

Allows you to exclude patients who have had a recent office visit.

Previous Office Journal
Before

Allows you to exclude patients who have had a recent entry in the
Office Journal.

Insurance Minimum Days
Past Due

Allows you to filter the list according to the age of outstanding
insurance claims.

For Payment Agreement &
Future Due Payment Plans

Allows you to filter the list according to whether the account has a
payment agreement or future due payment plan set up.
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Using the Office Journal to Review Patient Contact from Organizing Your Notes in Dentrix

Have you ever been making reminder calls and had a patient tell you that they just got a call from
someone else at your office? If you’re using the Office Journal to record your patient contacts, you can
prevent multiple people in the office from calling the same patient because everyone in the office can see
exactly when a patient was contacted last and what the contact was about.
To record contact with a patient:
1. From any Dentrix module, click the Office Journal button.
2. The Office Journal launches with the current patient
displayed. To switch to a different patient, click the Select
Patient button and choose a patient.
3. Click the Add Journal Entry button. The Add Journal Entry –
[patient name] dialog box appears.
4. Select the Type of contact you want to record from the dropdown list.
5. Select the Provider/Staff that had contact with the patient.
6. Enter a short description of the entry in the Description field
(such as Collection Call, Appointment Confirmation, etc.).
7. Enter any notes regarding the entry in the Note field.
8. Click OK to return to the Office Journal.

Assign a Default Provider to a Continuing Care Type from Dentrix Continuing Care from the Hygiene Chair
Did you know you can assign a provider to a patient’s continuing care type? If you have multiple hygienists in your
office and you have a patient that prefers to be seen by a specific hygienist, you can assign the default provider for that
patient to be the provider they prefer. That way you don’t have to try to remember each patient’s preferences.
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To assign a default provider to a continuing care type:
1. From the Family File, double-click the Continuing Care block. The selected patient’s Dentrix Continuing Care
dialog box appears.
2. In the Dentrix Continuing Care dialog box, highlight
the continuing care type you want to assign a default
provider to, and click Edit… The Edit Continuing Care
dialog box appears.
3. Mark the correct provider for the continuing care type
in the Provider group box. Prov1 and Prov2 are the
patient’s default providers in the Family File. To select
a specific provider other than the default provider from
the Family File, select Spec and choose the provider
from the drop-down list.
4. Click OK to save your changes and return to the
Continuing Care dialog box. Customize other
continuing care types as needed.
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Generating the Scheduled Patient Summary from 50 Things You Didn’t Know Dentrix Could Do

The Scheduled Patient Summary is an important tool to use in your daily morning meetings. It lists all
the patients you have scheduled that day and gives you important information about those patients. The
report shows you which patients have treatment plans, are overdue for continuing care, have an unscheduled
appointment, and more, and you can customize which information is displayed in the columns on the report. You can
use this information to talk with your staff members about opportunities you have to discuss future appointments or
other patient needs with the patients when they come in today.
To generate the Scheduled Patient Summary:
1. From the Appointment Book, click File >
Print Daily Huddle Report or click the Daily
Huddle Report button. The Daily Huddle
Report dialog box appears.
2. Check Scheduled Patients Summary to
include the summary when you generate
the rest of the report.
3. Click Scheduled Patients Setup to select
which columns you want to display on
the summary.
4. Click Preview to generate the Scheduled
Patients Summary.

Viewing All of a Patient’s Clinical Notes in One List from Using Dentrix Clinical Notes to Document Patient Care
Many doctors and hygienists like to review their past clinical notes about patients at the beginning of that patient’s
appointment. That way they see any notes they made about the patient’s health or treatment that they might need to
be aware of for this visit. You can open a list that displays all of the clinical notes at once so the providers can see all of
their clinical notes at once and review them the same way they would in a paper chart.
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To view all clinical notes at once:
1. Select the appropriate patient in the Patient Chart.
2. Click the Progress Notes tab to open the Progress Notes panel.
3. On the Progress Notes toolbar, select the Clinical Notes and Expand Notes view options. All of the clinical
notes for the patient will be displayed in the progress notes list with the notes expanded so you can see the text
of each one.
4. If desired, deselect any other view options that are selected so that the only things being displayed in the list
are the expanded clinical notes.
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Viewing Past Reports from The Dentrix Practice Advisor Report

y
it

Not only is it important to measure statistics relating to your practice using current data, but it’s
important to compare that current data to past data so you can view trends, track changes, and measure
improvements. The Practice Advisor stores a library of the reports you have generated so that at any time you
can select one of your past reports and view it.

To view past reports:
1. From the Office Manager, select Analysis > Practice Advisor. The Practice Advisor dialog box appears.
2. Click Report History. The Practice Advisor Report History dialog box appears.
3. Click the + next to Practice Advisor Report to expand the list of past reports.
4. The reports are listed by date, and within the date, are listed by the time of day the report was run. Find
the date of the report you want to view, click the + to expand that date, and sevlect the time of the report
you want to view.
5. Click Preview to preview that report.

Modifying Patient-Friendly Procedure Descriptions

You can avoid costly claim denials or delays by
including a brief narrative explaining the clinical
reasons for completing treatment. By creating
templates for frequently used claim remarks, you can
save time by not having to type the same narrative
repetitively each time a new claim is created.
To set up a custom claim remark template:
1. From the Office Manager, click Maintenance
> Practice Setup > Custom Notes > Claim
Remarks Setup. The Custom Claim Remarks
Setup dialog box appears.
2. Click New. The New Custom Claim Remark
dialog box appears.
3. In the Description field, enter a description
for the claim remark.
4. In the Note field, enter a brief claim remark.
		 Note: You’ll be able to edit the template on
a per-patient basis, so don’t include actual
tooth or surface information in the template
you create.
5. Click OK.
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Then when you create claims in the future, it only
takes a few seconds to add claim remarks using the
templates you create. You just have to make a few
adjustments to the template by adding tooth
numbers or surfaces, all without having to
track down the doctor to double-check
that you got the wording right.

When you use patient-friendly procedure descriptions, instead
of displaying the technical description for a procedure, a
less-technical description appears so patients will be able to
easily understand the procedures in treatment plans. If you
treat patients who speak a language other than English, you
can also use patient-friendly descriptions as a translation of the
procedure information.
To view the patient-friendly descriptions that are set up in
Dentrix, from the View menu in the Treatment Planner, click
Use Patient-Friendly Descriptions.
To add or customize a procedure description:
1. In the Treatment Planner, click the Settings button
in the Navigation panel. The Settings section of the
Navigation panel appears.
2. Click the Patient-Friendly Description button. The
Patient-Friendly Description Setup dialog box appears.

3. Select a procedure from the Procedure list.
4. If the procedure already has a patient-friendly
description, customize it as needed to fit the needs
of your patients. If the procedure does not already
include a patient-friendly description, enter a
procedure description that will make sense to your
patients in the Patient-Friendly Description field.
5. Click OK to save the changes to a procedure.
6. Repeat the process to add as many
descriptions as you need.
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Setting up Custom Claim Remark Templates
from Streamlining Insurance Processes with Dentrix

from Managing Treatment Plans with the Dentrix Treatment Planner
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Top Tips
from the
2014 Dentrix
Business of
Dentistry
Conference
Attendees at the 2014 Business of Dentistry
Conference experienced a world-class conference
at a destination resort in Las Vegas. In addition to
the exciting entertainment at the welcome reception
and the inspiring words of two keynote speakers,
attendees got advice and insight from leading
dental industry consultants and tips and tricks from
Dentrix experts.
Held in August at The Cosmopolitan of Las Vegas,
the 2014 Business of Dentistry conference offered
more than 60 total classes, two inspiring keynote
sessions, a learning lab staffed with senior support
technicians, an exhibitor’s hall that featured exciting
new product integrations, and free practice
assessments conducted by Dentrix profitability
coaches. Conference attendees gained valuable
insights about how to manage their practice more
effectively and efficiently and how to use Dentrix to
make their daily tasks easier and more efficient.
If you attended the conference, use the following
summaries to remind you of what you learned. If
you didn’t attend, read these summaries to get a
sampling of the professional development learning
that went on.
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Stress Free Claims and Collections
Lois Banta

benefits and the outcome of their dental claims. These are
some of the main reasons we have frustration in our collection efforts today.

If you took a poll of all the dental offices across America,
their top two frustrations would be the challenge of dealing

Follow these simple guidelines to help reduce your stress

with insurance claims and effectively collecting monies owed

about claims and collections:

from patients. Dental benefit plans don’t pay well, claims get

•

Remember to always: be confident, be positive, be
matter-of-fact

delayed or lost in the processing, claims reviewers will often
lower payment on a dental treatment by paying an alternate

•

Ask for payment on the day of service or before

benefit, and patients sometimes don’t pay their bills.

•

Get the correct information in the right order

•

Involve the patient in each step of the process

•

Be accurate, code the claim correctly, and don’t

With dental plans numbering in the thousands, there are

commit fraud!

countless confusing rules and regulations in the processing.
There are exclusions, alternate benefit guidelines,
processing policies, frequency limitations, and complicated
addresses, to name a few.
Needless to say, many mistakes are made in filing these
claims, causing the need for multiple submissions. This in
turn causes delays resulting in an out-of-control accounts
receivable. For years dentistry has allowed patients to

•

Track your claims
Lois Banta is CEO, President and Founder
of Banta Consulting, Inc., a company that
specializes in all aspects of dental practice
management. To contact Lois for a personal
consultation or to invite Lois to speak to your
organization; Office-816/847-2055, Address:
33010 NE Pink Hill Rd, Grain Valley, MO 64029,
Email: lois@bantaconsulting.com or check out
her website: www.bantaconsulting.com.

depend on them 100% for the accuracy of their dental
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Secrets to Same Day Dentistry
Dr. John Meis and Wendy Briggs
Dentistry is changing! What patients want is different today than in years
past. The most successful in our profession are those who are adapting to
these changes and are making adjustments to their practices to become
more convenient for patients.
We teach 10 reasons to do more same-day dentistry (which we define as
dentistry that is not on your schedule at the beginning of the day.) We will
share five of them with you here.
•

Patient Convenience. According to Dentistry IQ, “Today’s busy
patients demand convenience and accessibility. Extended office
hours during the week are important to 57 percent of those surveyed.
Nearly half of patients look for dentists offering weekend hours.”1

•

Offering treatment today eliminates future broken appointments
and cancellations. Keeping the schedule full and productive is a real
challenge for many practices.

•

Same-day dentistry makes unproductive time productive! We have
seen one dentist that was scheduled to have a $4,000 day, offer
same-day service and end up having a $16,000 day. This is just one
example of making unproductive time very productive!

•

Doing more today dramatically increases productivity without raising
overhead very much. When you are able to add additional procedures
into your day, your profitability is impacted in a powerful way.

•

Changes in the perspective of the team: every broken appointment
or cancellation is an opportunity! It’s an opportunity to increase
production by offering a higher level of service to the patients that
are already scheduled.

Practices that have systems in place to offer same day restorative and do it
well often see between 30-50 percent in additional production that wasn’t
on their books at the beginning of the day. What we love about same-day
dentistry is that with our changing society, we are able to be hyper-convenient for our patients, and help fuel practice growth at the same time.
Dr. John Meis is a practicing dentist and a partner in more than
89 successful dental practices employing over 900 team members
in the United States. He knows from first-hand experience how to
manage and inspire a dental team. He is also a top producer. His
tremendous systems, which drive productivity and effectiveness
in the dental practice, increased production in his own practice by
more than 40 percent. Dr. Meis has mentored hundreds of dentists
across the country through The Team Training Institute, a consulting
and training organization he co-founded with Wendy Briggs, RDH.
Wendy Briggs is president and CEO of Hygiene Diamonds, a
worldwide practice management consulting firm which excels
in increasing entire practice profitability and improving oral
hygiene systems. Her trademarked Whitening for Life™ program
has proven successful in more than 21 countries. Wendy is also
a partner with Dr. John Meis in The Team Training Institute, a
consulting and training organization that has helped more than
1,200 practices worldwide achieve their goals. Wendy lectures
internationally, she is a contributing educator for the Dawson
Academy, and she works as a recommended hygiene consultant
for Henry Schein.

14 | www.Dentrix.com/Magazine

2013 Dentistry IQ When asked if they would like their restorative dentistry done today, it’s
surprising how many patients say yes.

1

Increasing Treatment and Getting Paid
Debra Engelhardt-Nash

Managing by the Numbers
Amy Morgan

A 5 percent increase in treatment acceptance and collections

Amy Morgan, CEO Pride Institute, focused her foundational

can dramatically increase practice productivity. Here are a few

training on the five basic elements needed to run a

tips that may boost your productivity:

successful practice:

•

•

•

•

•

•

•
•

•

Spend more time on “people work” than on paperwork.
80 percent of the decision to choose your care is based on
the ability to connect with your patient. Get to know your
patients and earn their trust before you start informing
them of office policies. And they’ll be more compliant if
they like you.
Always present ideal treatment first. The patient will
never choose your comprehensive treatment plan if they
never hear about it.
Begin with the end in mind. Patients may be more
motivated for periodontal care if they know there is a
beautiful, healthy smile waiting at the end. Describe the
benefits of their care.
Don’t forget recare. There are a lot of incomplete
treatment plans hovering over existing patients. Learn how
to re-introduce incomplete treatment and new treatment
during continuing care appointments.
Increase patient comfort. No hard pressure sales—it’s all
elective. Patients will feel more relaxed and more comfortable
listening to treatment options. Give them the information
they need to be comfortable and confident in your care.
Make the conversation matter. You are asking the patient
to make an investment. It should be done privately and
given the time it deserves with no interruptions.
Present with confidence. Don’t assume the patient will
have an issue with your fees or your payment expectations.
Learn to negotiate. Financial arrangements are a two-way
conversation. Present your preferred option first and wait
for the patient to respond. Avoid lists of payment options.
Know what they are and reveal them as needed.
Ask the right questions. “What is preventing you from
proceeding with care?” You may be able to help eliminate
or minimize the barriers if you know what they are.

Debra Engelhardt-Nash has been in dentistry over
25 years. She is a trainer, author, presenter, and
consultant who has presented workshops nationally
and internationally. She was a contributing editor for
Contemporary Esthetics and Restorative Practice
and an editorial board member for Contemporary
Assisting. Debra was also an instructor for the Central
Piedmont Community College Dental Assisting
Program and a guest instructor for Medical College of
Georgia School of Dentistry. Debra is a founding member and former president
of the National Academy of Dental Management Consultants. She is an active
member of the American Dental Assistants Association and the American
Academy of Dental Practice Administration. Debra has been listed in Dentistry
Today as a leader in continuing dental education and dental consulting since
2005. She received the American Dental Assistants Association’s highest honor,
the Kay Moser Distinguished Service Award, in 2008, and she has been chosen
as one of the Top 25 Women in Dentistry for 2014 by Dental Products Report.
Debra will be the 2015 recipient of the Gordon Christensen Lecturer Recognition
award, which will be presented during the 150th Chicago Midwinter Meeting.

•

Create a vision that supports your values

•

Set smart goals that support and promote your vision

•

Analyze by statistics (not judgment) to prioritize success
and challenges to your vision

•

Upgrade your practice systems to achieve your goals

•

Hire, train, and reward the “KSAs” (knowledge, skills
and abilities/attitudes) needed to run your systems and
achieve your vision

Using the Dentrix Practice Advisor dashboard as part of the key
case study for statistical analysis, she presented a comprehensive approach to managing your practice by the numbers, while
leading your team to new levels of success.
Here are five tips from Amy Morgan:
1.

To be successful in a small business, it is essential that the
owner must be comfortable wearing three hats – Clinician
(“do-er”), Leader (visionary), and Manager (organizer/
implementer).

2.

The active patient base number (any patient seen for
anything in the practice in the last 18 months) is an essential statistic that tells the leadership team everything from
production potential to when to bring in associates and
how many hygiene days are needed per week to support
the base.

3.

There are four stages of team development: Forming,
Storming, Norming, and Performing. Each stage requires
a different mix of leadership and management to successfully coach continuous growth and improvement

4.

Looking at office expenses through the lens of total office
production is essential for cash flow management, as
production generates the expense – not collections.

5.

Any team compensation and reward models must be
competitive with what the market will bear, affordable for the
practice to pay, and be based on individual merit.

Amy Morgan is a renowned dental consultant and the
chief executive officer of Pride Institute. Since joining
the institute as a consultant in 1993, she has refined
and enhanced its time-proven management systems,
which have revitalized thousands of general and
specialty dental practices—helping them become
more secure, efficient, and profitable. Amy is a highly
sought-after educator throughout North America
and Europe who has been a featured speaker at
major dental meetings and has been published. To find out more about Pride
Institute and how we can help you lead/manage your practice to new levels of
success, visit the website www.prideinstitute.com and “Like us” on Facebook.
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Schedule for Productivity, Profitability, and
Stress Control
Cathy Jameson

Create a Dream Team and Win More
Patients Over
Dr. Tanya Brown

Scheduling is the heartbeat of the dental practice. A well-

Everyone wants to be a rock star! Rock star dental teams

scheduled day can lead to productivity, profitability, and stress

are made up of leaders who take responsibility for their

control, and will support the quality care of your patients.

own destiny and actively hone their communication skills.
This process starts with an honest assessment of one’s

At The Jameson Group, we believe that there are 8 Essentials

own strengths, goals, and obstacles. Each person on a

of Scheduling:

team has a role, and real leadership means bringing our

1.
2.

Schedule toward a pre-determined goal: yearly,

best to that role every day. It also means taking control of

monthly, and daily.

improving on our weaknesses and seeking ways to break

Schedule a variety of procedures every day: primary,

down obstacles as a team.

secondary, tertiary.
3.
4.

5.
6.

7.
8.

Pre-block for approximately ½ of your daily goal with

One of the greatest obstacles we face is our inner

primary procedures.

voice. It tells us that we can’t or shouldn’t. We make

Implement appropriate delegation (according to the

assumptions based upon our beliefs such as “they can’t

laws of your state) so that the doctor is doing the things

afford this” or “I shouldn’t overstep my bounds and

that only a doctor can do.

make this recommendation.” These beliefs affect our

Do a time-in-motion study to realize accuracy in time

behavior such that we limit our results. Now we have

allotments. Schedule both doctor time and assistant time.

impacted the type of relationship we have with our

Provide hygiene evaluations at a natural break in the

patients and become a “service provider” rather than

doctor’s schedule rather than at the end of a hygiene

a trusted clinician. This ultimately affects our patient’s

appointment.

care and our profitability.

Make financial arrangements prior to the scheduling of
an appointment.

There is a better way! Break down each patient

Schedule fewer patients in a day, doing more dentistry

interaction and examine ways to improve phone skills,

when and where appropriate, and see the patient for

greeting patients, and financial arrangements, as well as

fewer visits. They will appreciate you and your daily

co-diagnosis and patient education.

productivity will increase, it’s a profitable way to
practice, and much less stressful.

Rock star dental teams are vigilant to eradicate
negativity. Deal directly with the perpetual gossiper, the

Know that the key to productivity is not how many patients

habitual complainer, and the blamer by engaging them

you are seeing in a day but, rather, how much dentistry you

in solutions, not problems. Finding ways to turn things

are doing in a day. That’s the key.

around in a positive way can change the culture of a
practice.

No matter how well you may think that you are scheduling at
this time, do yourself a favor and look for places where you

Finally, the most successful teams have protocols

can tweak or improve upon each of the eight areas above.

for everything, including periodontal treatment,

Remember: The schedule is the heartbeat of your practice.

photography, new patient call sheets, etc. Decide where

Take good care of it!

you and your team want to start and take the first step on

Cathy Jameson is the founder and chief
visionary officer of Jameson Management, an
international dental management, marketing,
and hygiene coaching firm. The Jameson
Method of Management, developed by
Cathy, offers proven management, marketing,
and hygiene systems for helping dental
professionals improve their practices. Cathy
earned a bachelor’s degree in education from
the University of Nebraska at Omaha and then a master’s degree in
psychology from Goddard College. She recently received her doctorate
from Walden University. She considers herself a lifelong learner and
encourages those around her to be in a constant state of study, growth,
and action.
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the road to becoming a rock star team!
Dr. Tanya Brown’s speaking attendees
and consulting clients benefit from her
360-degree, cumulative experience in the
dental practice—from chairside dental
assistant, to practice administrator, to
owner dentist and founder of the Center
for Cosmetic & Restorative Dentistry. She
is a fellow of the AGD and a member of
the AACD, ADA, Speaking Consulting
Network, and Professional Management Consultants Association. In
her compelling lectures, Dr. Brown honors each member of the team
as a vital contributor to the success of the dental practice.

No Dose.

Lower Dose.

DEXIS CariVu is the no-dose solution* for
detecting caries with 99% accuracy and
displaying images in easy-to-read black &
white. Patented transillumination technology
allows you to see caries like never before
and offers a new diagnostic tool for patients
when x-rays are difficult or unwanted.

With the best image quality over a broader
exposure range — and most importantly, at
the lowest doses** — the DEXIS Platinum
System delivers unparalleled radiographic
images that are extremely clear, sharp and
highly detailed. Patients benefit from the
reduction in exposure.

SCHEDULE
YOUR ONLINE

DEMO
1-678-527-1005
CariVu Specialist

Dealer Partner:

1-888-883-3947 | www.dexis.com
1-800-645-6594 | www.henryscheindental.com

*CariVu uses no ionizing radiation. Proximal dentin lesions represented in CariVu images correlate to the actual condition in the tooth with 99% accuracy. For
CariVu ‘Indications for Use’ visit www.dexis.com/ifu. | **DEXIS’ proprietary hardware and DEXIS software work together to produce the most consistent
diagnostic images at the widest exposure range of radiation dose and the best image quality results at the lowest dose. In a laboratory setting, the optional
DEXshield positioning device plus the DEXIS Platinum Sensor was determined to reduce absorbed dose by at least 30% as compared to the Universal Ring
plus the DEXIS Platinum Sensor. Additional data on file.
©2014 DEXIS, LLC DX51991014REV0.5246

The Dentrix Office Manager
Manage Your Complex Office Schedule
Within Dentrix
Simplify setting up your practice’s complex schedule in the Dentrix Appointment Book with an
easy-to-follow three-tier approach.

Dayna Johnson | Certified Dentrix Trainer

D

id you know that Dentrix provides
a three-tier hierarchy for setting
up your practice hours to help
you manage a complex office schedule?
For example, let’s say that you have a
hygienist who comes in at 10:00 every
morning, but the rest of the office
starts their workday at 8:00. And one
of your operatories is used for training
every Friday afternoon and is therefore
unavailable for appointment scheduling.
How would you set up this schedule in the
Dentrix Appointment Book?
This article explains the three tiers
you use when setting up your practice’s
schedule in Dentrix. Having your office,
provider, and operatory hours set up
properly will help ensure that many of your
Dentrix reports are reporting accurate
information. Furthermore, when your
provider hours are set up correctly, Dentrix
will send appropriate warning messages
to your team that can help prevent
embarrassing scheduling mistakes.
Follow the three steps in this article
to ensure that your complex schedule is
captured in Dentrix to improve scheduling
and reporting accuracy and increase
practice organization.

Setting up Practice Hours
Begin by setting up default business
hours for the entire practice. From the
Setup menu in the Appointment Book,
click Practice Appointment Setup. In the
Practice Appointment Setup dialog box
select each day that the office is open. Even if
your practice is only open a couple of Fridays
each month, make sure you include Fridays
in this setup. Then, next to each day, click the
>> icon, and in the Set Time Limits dialog
box (Figure 1), specify the hours that the
practice is open that day, leaving time for the
lunch break. Click OK twice when finished.
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After setting up the default days
and hours, from the Setup menu, click
Practice Schedule and navigate to any
dates that you want to close the office or
set as an annual holiday. From the Office
Closed menu, click either Close Office on
selected date or Set Yearly Holiday on
selected day. When finished, click Close.

Setting up Provider Hours
Next, you want to set default hours
for each of your active providers. From
the Setup menu in the Appointment
Book, click Provider Setup. With the first
provider selected, click Setup and select
each day this provider might work. (Even if
the provider only works every other Friday,
make sure you select Friday.) Then, next
to each day, click the >> icon, and specify
the hours that the provider is working that
day (again leaving time for a lunch break).
Click OK twice when finished.
If you need to change the hours for a
particular day in this provider’s schedule,
click Schedule, and then navigate to any
date when you want to schedule time off
for the provider. From the Options menu,
click Set Vacation on selected date. When
finished scheduling time off for this provider,
click Close, and then repeat these steps for
all other active providers. If you have other
providers in your system, make sure all their
days are cleared. This will ensure that your
Practice Advisor Report and other reports
are as accurate as possible.
Setting up Operatory Hours
The last place where you can edit the
office hours is in the operatory setup. This
will change the default practice setup for
specific treatment rooms. From the Setup
menu in the Appointment Book, click
Operatory Setup. With the first operatory
selected, click Setup and select each day

this operatory
might be used.
(Again, even if
the operatory
is used only
every other
Friday, make
sure you select
Friday). Then,
next to each
Figure 1 The Set Time
day, click the
Limits dialog box.
>> icon, and
specify the
hours that the operatory is used that day.
Click OK twice when finished.
If you want to close the operatory for
specific days or schedule hours, you can
click Schedule from the Operatory Setup
dialog box, or you can right-click in the
Appointment Book and choose Schedule
Event from the shortcut menu.
Using this simple three-tier approach
makes it easy to set up your practice’s
complex schedule.

LEARN MORE
To learn more, see the “Setting up practice
hours,” “Setting up providers,” and “Setting
up operatories” topics in the Dentrix Help.
See “How to Learn More” on page 2 for
instructions on accessing these resources.
Dayna Johnson, founder and principal
consultant of Rae Dental Management, helps
dental offices improve patient care, increase
collections, and reduce staff headaches by
implementing efficient management systems.
With 20 years of experience in the business
and technical side of dental offices, Dayna’s
passion for efficient systems is grounded
in both personal understanding and
professional expertise. Dayna can be reached
at Dayna@RaeDentalManagement.com or visit
her website at www.RaeDentalManagement.com.

Get Dentrix News,
Tips and Information
Sent Right to Your Inbox.
The Dentrix eNewsletter will help you stay up to date on the latest Dentrix
product information, education opportunities, industry news, tips and
tricks, promotional offers and more! Once a month you’ll receive an
eNewsletter featuring the following content:

Product
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& Support
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Partner
Products

Tips
& Tricks

Sign Up Today at www.Dentrix.com/newsletter
and don’t miss out on the most up-to-date Dentrix information!
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From the Coach
Understand Your Patient Accounts Better
with Dentrix Billing Types
Discover how using billing types helps you streamline collections and get more focused
information in your reports.

Cris Hays | Dentrix Profitability Coach

A

s we go about our day, checking
patients in and out, creating new
patient accounts, and talking
about treatment plans, we don’t often
stop to think about how we categorize
our patient accounts. We definitely don’t
think about how account labels can make
our everyday tasks easier. But they can!
Knowing more about your patient accounts
not only helps you in your everyday work,
but also helps you to make more informed
business management decisions.
Dentrix gives you the ability to apply a
label to each patient account with a billing
type. When you use billing types, you can
easily identify the collection situation of an
account, collect payments more effectively
at the time of service and beyond, and
get more focused information out of the
regular reports you use.

can assign billing types from either the
Family File or the Ledger. From the Family
File, double-click the account information
block. From the Ledger, click File > Billing/
Payment Agreement. In the Billing/
Payment Agreement Information dialog
box (Figure 2), select the billing type you
want to assign from the Billing Type list, and
then click OK.

Figure 1 You can easily see a patient’s
Identify the Accounts You Want
billing type in the Family File or Ledger.
to Track
Have you ever wanted to get specific
information about your PPO accounts? Do
Improve Your Collection Routines
you want to know how many patients have
Billing types will help your team know
signed up for your in-house discount plan? how to better handle collections on
Do you want to identify special accounts
patient accounts. For example, you can use
like Medicaid or staff member accounts?
billing types to see patients who have no
Create a billing type for them!
co-pay, patients who are part of your office
When you use billing types that are
discount plan, and so forth.
meaningful to your office, everyone in
When it comes time to run billing
the office can be on the same page. For
statements for the month, you can quickly
example, if you attach a billing type to
generate statements for specific groups of
your non-insured patients, you can easily
see that billing type in the Family File and
Ledger (Figure 1). Then, as you check those
patients out, you will know that you need
to collect payment for services today.
Assign a Billing Type to Your Accounts
Billing types are account-specific,
meaning that all the patients within a family
will be assigned the same billing type. You
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patients because you can filter statements
by billing type. You can even exclude
billing types from your statement run, such
as accounts sent to collections.

Get Custom Report Data
Many reports in Dentrix can be filtered
by billing type. You can generate the
reports for a specific billing type, or you
can exclude certain billing types from the
totals on the reports.
For example, you can generate the
Patient List and filter it by billing type to
find accounts with no insurance or accounts
on a specific PPO insurance plan. Or, you
can find the exact accounts receivable
belonging to all patients assigned to a
specific billing type by including only that
billing type in your Aging Report filters.
You can also use billing types to create
and send letters to specific groups of
patients. If you want to generate letters for
all of your uninsured patients to offer them
membership in your new dental health
savings plan, you can do so quickly if you
have all of your non-insurance patients
attached to a billing type.
If you want to take patient account
management to the next level, billing types
can help you. Billing types can help you get
more information out of Dentrix reports,
collect money more effectively on the date
of service, and make educated decisions
about the management of your practice.

Figure 2 Assigning patients to a billing type helps you find
information about specific groups of patients.
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Let our experts show you how to put all the features of Dentrix to work for
your practice, and help you identify the reports and performance metrics you
should focus on to gain greater profitability.

With Dentrix Profitability Coaching you’ll learn ways to:
• Improve coding accuracies

• Give more accurate patient estimates

• Keep patients coming back

• Get timely insurance payments

• Collect what you produce

• Keep your schedules filled

• Increase treatment acceptance rates

• Go paperless

After six months, the average coaching customer has
realized an $8,000 increase in their monthly cash flow.

Visit www.Dentrix.com/Coach
2014 Henry Schein Inc

Business of Dentistry
How to Turn a Difficult Patient Into a Raving Fan
Use these five strategies to help you deal with difficult patients and provide them with
outstanding customer service.

Linda Larsen | Certified Speaking Professional

S

tand here, bite down on the mouth
piece and take a step forward,” the
dental assistant said as she put me
in the zippy 3D panoramic X-ray
machine. It was clear she wasn’t thrilled
to be doing this since I was being seen
on an emergency basis right at closing
time and this was making her stay late.
I did as she asked.
“No, step forward,” she repeated
with a nonverbal tone that said,
“Didn’t you hear what I said?”
Since stepping forward was now
throwing off my balance, I took only
a small step. Yes, I was holding onto
the little handles in the machine,
but I had now begun to lean backwards with each step forward. I kept
thinking, “This can’t be right.”
“No. I said step forward. You’re
doing this! I want you to do this!” she
impatiently barked. She proceeded to
demonstrate with her feet. I could feel
my blood pressure starting to elevate.
Since I had my mouth locked in on
the mouthpiece and couldn’t possibly
see what she was doing with her feet,
I released my bite, stepped back from
the machine and said, “I cannot see
what you are trying to show me.”
“You don’t need to SEE what I’m
doing. I’m saying step forward and
you’re taking these little tiny steps!”
Really? She is snapping at me like
I’m some recalcitrant child? Seriously?
I grabbed the handles, repositioned
my mouth and took a huge step
forward. This forced me to lean way
back, totally off balance, and remain
there while she completed her task.
When we were finished, I didn’t even
try to hide my annoyance. I said to her,
“If a patient doesn’t understand your
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instructions, maybe you need to figure
out where the breakdown is occurring.”
“I told you to step forward and you
didn’t do it. What’s not to understand?”
And that’s when my brain scrambled.
“If you would let me tell you what my
problem was with your instructions, you

breathe and calm down. And I begin
writing this article in my mind.
It starts with this question: Should
you, as a staff member in your dental
office, allow yourself the luxury of getting
annoyed with a patient who isn’t doing
what you want them to do? A patient

might not frustrate the next patient the
way you have totally frustrated me.”
She promptly turned on her heel
and walked away. Walked. Away.
Okay, breathing. I’m now breathing. As a motivational speaker who
talks a lot about the power of effective communication I know that, in
this moment, I need to take no action
other than to simply breathe. Just

who can’t understand the simplest of
instructions, and who has the audacity
to actually get annoyed with you?
And the answer is: Never. Ever.
Ever. Here are the reasons why:
• You are familiar with everything in your
office—they are familiar with nothing.
This is all new to them.
• Many people get very anxious when
visiting the dentist. They are on high

alert. They are in a fight-or-flight mode
and view everything they see, hear,
taste, smell or touch as a potential
danger. Oh, and that includes you.
• It is not their job to be nice, friendly,
happy, and kind to YOU!
• They are looking for any reason to
walk out of your office and never come
back. Don’t give them one.
• And my number one customer/patient
service rule: The one putting the
money on the table wins.
First, let me be clear. I’m not talking
about putting up with physical or verbal
abuse. If someone is in any way threatening you, here’s your response: “Mr.
Smith I can see how upset you are and
I want to fix this situation immediately.
Let me bring in my (office manager,
co-worker, dentist, someone) to help us.”
What I am talking about are those
patients (like me, apparently) who simply
do not understand the directions. The
ones who ask you the same question
three times. The ones who turn their
head to the left when you say turn it
to the right. The list goes on and on.
I must reiterate that visiting a dentist
for many people can be a scary, nerveracking, unhappy experience. And when
a person is under high stress, they might
not process information very quickly.
They may use coping strategies that
are not the most effective. They may
act or react in incongruent ways. But
they are your patients. They are the
ones putting the money on the table.
They deserve the very best that you
can give them. And I contend that your
very best is even better than you think.
Here are a few strategies that
you can employ to help you deal
with someone…well, like me.
1. Explain everything as you go along.
“This may taste a little funny, but it will
dissipate very quickly.” “You’re going
to hear a beep and that will signal…”
“We are going to remove your temporary now and you will feel...”
2. When you perceive someone isn’t
understanding… “I’m so sorry. I
must not be explaining this well.
Let me rephrase my instructions.”

Ask yourself: “Is what I am about to do or
say going to get me that rave review?”

(I wouldn’t be writing this if that
woman in my dentist’s office had
said these words.)
3. Set a positive, helpful tone as early
as possible.
“Mrs. Thompson, I can see you are
apprehensive about this. Please know
that my job is to make you as comfortable and happy as possible. I’m going
to explain everything as we go along,
answer any questions you may have,
and make certain you are doing great.
Please let me know if there’s anything
you need as we proceed.”
4. Smile a lot, kindly and sincerely. You
have no idea how comforting it is when
you are anxious to see warm, happy,
smiling faces. I’m not merely talking
about being nice and giving good
service. That’s basic. I’m talking about
taking your service to the highest level
possible. I’m talking about tuning in
to each patient as if there is no one
else in the building; as if their comfort
and well-being are what you are totally
living for in that moment. Read their
non-verbal behavior and respond
accordingly. Be kind. Be patient. Take
nothing personally.
5. Assume that the person you are
serving right now is going to go home
and write a blog post about you that
will be read by thousands of people.
Or maybe they’ll just post a comment
on Facebook to their 2,133 friends.
What do you want them to write about
you? Do you want them sharing an
experience like the one I had? One
that ends with, “Run! Run for your life!”
Or would you prefer something like the
following rave review?

“Wow! The entire staff at Dr.
__________’s office is amazing! Not
just great – but exceptionally great!
Especially __________! She made
me feel like I was the most important
patient they had all day! It seemed like
her main concern was that I be happy
and comfortable. She was incredibly
kind and patient and went out of her
way to make certain I understood
everything that was happening. I can
now honestly say I love going to the
dentist! If you are looking for an amazingly positive and enjoyable experience
at the dentist, this is the place!”
And if you’d like the rave review, then
here’s the big question to ask yourself
in every given patient interaction: Is
what I am about to do or say (and how
I am about to do or say it) going to get
me that rave review? That’s a sure-fire
way to create the results you want.
Linda Larsen, motivational speaker,
author and trainer, helps dental practices build Super Star Teams who create
deliriously happy, loyal patients for life!
Linda gives people the tools to enable
them to bring the absolute best version of
themselves to the party, enhance innovative
thinking, improve effective communication
and provide exceptional patient service! A
favorite speaker in the dental industry, she
received rave reviews as the keynote speaker
at the 2013 AADOM annual meeting. She can
be reached at 941-927-4700.
Originally published on Linda’s Positively
Speaking Blog. Rants & Raves by Funny
Motivational Speaker Linda Larsen
By Linda Larsen - Wednesday, April 02, 2014
http://www.lindalarsen.com/lindas-positivelyspeaking-blog/how-to-turn-a-difficultpatient-into-your-greatest-raving-fan
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TechNotes
Multi-Layered Security: The Best Defense
Understand the rules and requirements for data security.

Brad Royer | Dentrix Product Manager

I

n the late twelfth and early thirteenth centuries, defense strategies
for castles, the most prominent fortification for nobles, underwent significant changes. While earlier castles had
some forms of defense, their defenses
were often weak and relied heavily on
moats and the central keep—a fortified tower within the castle. One of the
greatest improvements in later castles’
defense strategy was the implementation of a “concentric defense,” which
provided “several stages of defense
within each other that could all function at the same time to maximize the
castle’s firepower.”1
Similar to castles, in the early days of
electronic health records, fortification

policies and practices were often weak
and vulnerable to attack. Since the Health
Insurance Portability and Accountability
Act of 1996 (HIPAA), requirements to
fortify against the improper use and
access of patient health information have
called for entities to improve strategies
and tactics. These requirements have
been reinforced with the HITECH Act
(Health Information Technology for
Economic and Clinical Health) of 2009
and the Omnibus Final Rule of 2013.

What Are the Rules?
At Henry Schein, we are working
to help providers know and understand the rules and requirements for
data security. In our January 2014

At Henry Schein, we are working to help
providers know and understand the rules
and requirements for data security.

eNewsletter article, “Dentrix and Data
Security—What You Need to Know,” we
emphasized that offices are responsible
to ensure that patient data is protected,
outlined some of the critical areas that
need to be considered, and highlighted
what we are doing to help. Similar to
later castle defense strategies, the
cumulative effects of each of these
policies and safeguards will increase
the protection of your practice.
One important defense strategy you
can implement is passwords. Your first
line of defense should be the vigilant
use of passwords in Dentrix and
Microsoft Windows. As with a castle
defense strategy, it is critical to
remember that Dentrix passwords are
only the first line of defense and must
not be the sole security method used.
In addition, the use of passwords is
required under HIPAA in the Technical
Safeguards (164.312) section of the law,
which includes five standards: Access
Controls, Audit Controls, Integrity,
Person or Entity Authentication and
Transmission Security. Without passwords enabled, providers cannot have
appropriate Audit Controls or Person or
Entity Authentication and are not able
to implement unique user identification within Dentrix, a requirement
under the Access Controls standard.

Who Is Responsible for Data
Encryption?
One area that is receiving a lot of
attention is encryption and decryption
for data at rest, an addressable item
under the Access Controls standard.

1
2

www.occultauctions.com/castles
Security 101 for Covered Entities (CMS, November 2004)
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Dr. Lorne Lavine, CEO and founder
of The Digital Dentist, stated, “The
vast majority of practices that we work
with, unfortunately, are not encrypting
their data.” There seems to be a lot of
confusion about who is responsible for
encryption and what to do if there is a
security breach.
Perhaps some of the confusion stems
from the fact that HIPAA refers to these
concepts as “addressable.” In “Security
101 for Covered Entities,” released by
the Centers for Medicare and Medicaid
Services (CMS), they note that “addressable does not mean optional.” The law
states: “When a standard adopted…
includes addressable implementation
specifications, a covered entity must:
1. Assess whether each
implementation specification is a
reasonable and appropriate safeguard
in its environment, when analyzed with
reference to the likely contribution
to protecting the entity’s electronic
protected health information; and as
applicable to the entity—
a. Implement the implementation
specification if reasonable and
appropriate; or
b. If implementing the
implementation specification is
not reasonable and appropriate,
document why it would not be
reasonable and appropriate to
implement the implementation
specification and implement an
equivalent alternative measure if
reasonable and appropriate.”
While the language is somewhat
difficult, HIPAA is clear that dentists
are responsible to ensure that their
data is protected and that encryption
plays a critical role in that.

Protect Yourself with Full Disk
Encryption
Older methods of defense, just
like the moat and central keep in
older castles, are not enough to
protect doctors from some forms of
data breach, and our customers must
take additional measures. Dr. Lavine
emphasized, “In the modern dental
practice, patients certainly have a right
and an expectation that information
that they share with the dentist is going
to be kept confidential, is going to be

kept secure while it’s in the dentist’s
presence. What we find is that a lot of
practices aren’t doing the necessary
steps to protect that.” One such step
is the use of full disk encryption (FDE).
Unlike master boot record (MBR), FDE
signifies that everything on the disk is
encrypted—including the programs that
can encrypt bootable operating systems
partitions—when part of the disk is
necessarily not encrypted.
Implementing full disk encryption
requires additional effort, but in the
long run it’s better than the alternative.
For example, late last year one Dentrix
customer, Dr. Meaglia, experienced his
worst nightmare when he arrived at work
to find that his server had been stolen.
Unfortunately, his patient data was
not secured using full disk encryption.
Under the Omnibus and HITECH acts, he
was required to follow the appropriate
breach notifications, which included notifying local and federal authorities, news
agencies, and his patients of the breach.
Needless to say, it had negative effects
on his reputation, both personally and
professionally. Not to mention the
fines he had to pay. To avoid a situation
like this in the future, he implemented
full disk encryption methodologies to
ensure that he and his customers would
be protected.
As with the implementation of passwords, full disk encryption should not be

the only form of security. In its “Guide
to Storage Encryption Technologies
for End User Devices,” the National
Institute of Standards and Technology
(NIST) states that full disk encryption
does not “mitigate OS and application layer threats (such as malware and
insider threats).”

Data Security Is More Than One
Battle; It Is a War
The Department of Health and
Human Services writes, “Security is
not a one-time project, but rather an
ongoing, dynamic process that will
create new challenges as covered
entities’ organizations and technologies change.”2
Henry Schein offers assistance in
implementing appropriate network security through TechCentral, our technology
experts. We strongly recommend that
our customers protect their practices by
consulting with TechCentral. TechCentral
offers proven security from web-based
threats via an active web firewall and
virus protection. Later this year, they
will offer new customers who purchase
a server or laptop the ability to implement full disk encryption using Microsoft
BitLocker. For more information about
the TechCentral Protected Practice, visit
www.HenryScheinTechCentral.com. To
speak with a Henry Schein TechCentral
expert today, call 877-483-0382.
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SOLUTION SPOTLIGHT

TeamLINKS and Dentrix:

Cloud-based Patient Records are the Future
of Healthcare
Larry Wiley | MHA CMPE and Richard D. Roblee, DDS MS

TeamLINKS provides added features and functionality to your Dentrix software, including interdisciplinary
care team collaboration by providers and patients, access to Meaningful Use incentive payments, and secure,
HIPAA-compliant PHI communication.

A

s the most widely-used electronic dental record, Dentrix
can do a lot for your practice, from electronic billing to
managing insurance to documenting treatment
planning. At the same time, Henry Schein recognizes that some
customers are looking for added features and functionality
through other vendors and has created the Dentrix Developer
Program (DDP) to assist these vendors. TeamLINKS is a proud
member of the DDP and can provide your practice with some
exciting solutions to improve the way you run your business and
care for patients.

give other authorized providers secure access to selected
records. And as a UHR, patients have access to their records
through usernames and passwords. Authorized providers
can add medical and dental history and manage any type
of diagnostic or treatment records, including radiographic
and clinical images, proprietary files, laboratory results,
and detailed clinical notes. Healthcare providers can also
use the TeamLINKS system for viewing and storing images,
communicating with vendors, maintaining a laboratory history,
and tracking implantable devices.

Universal Health Records (UHR)
Today’s patient records are stored in many types of
electronic systems. Provider-centric records such as Electronic
Medical/Health/Dental Records (EMR), (EHR), and (EDR) allow
very little patient participation in their upkeep. In fact, most
of these patient records are stored on local servers with no
access granted to patients or other providers. A Personal Health
Record (PHR), on the other hand, is a record edited and owned
by the patient but not accessible by the provider. A Universal
Health Record (UHR) allows patients to view and collaborate
with providers on their care.
TeamLINKS is all of the above and more. Our integrated,
cloud-based TeamLINKS system is a “patient centric” solution,
which means that providers all use a single patient record rather
than each having their own separate disconnected patient
charts. Patients also have access to their record.

Cloud-based Solutions Provide Big Benefits
At TeamLINKS, all personal health information (PHI) is stored
on secure, private, HIPAA-compliant, cloud-based servers.
Providers and patients access and update health records securely
from any web-enabled device. Patient data is stored securely in
the cloud instead of on local or mobile devices that can be lost
or damaged, so data is safe. TeamLINKS allows only authorized
users to access and modify patient data, giving practices the
security they need to maintain patient confidentiality.
Because providers and patients all view the same record,
TeamLINKS literally becomes a virtual Health Information
Exchange (HIE) for all users. And even non-TeamLINKS providers
can be given limited access through TeamLINKS Messenger
(TLM) discussed below.
TeamLINKS is fully integrated with Dentrix. This integration
allows TeamLINKS to pull the necessary patient data directly
out of Dentrix to reduce data entry time and increase
accuracy. The cloud-based system also eliminates the need for
expensive servers with maintenance contracts in your office. All
program updates are implemented at the cloud level and are
simultaneously available to all users, and you never have to back
up your data.

Interdisciplinary Provider and Patient Collaboration
TeamLINKS allows providers and patients to collaborate
in a single patient record to keep as much information as
possible in one place. Providers initially create and edit
patient records using TeamLINKS. The doctor can then
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Meaningful Use Incentives
The TeamLINKS MU2 package is a 2014 Meaningful Use
Certified EHR, which allows you to attest for “Meaningful Use”
government incentive payments. The government’s goal is to
connect every patient’s record with any provider, anywhere,
anytime, through electronic access. Through the HITECH Act,
incentive payments up to $63,750 over a period of six years are
available for “meaningfully using” a certified EHR and reporting
to Centers for Medicare & Medicaid Services (CMS) and your
state Medicaid office.
Eligible Providers (EP) must meet specific requirements,
which for dentists usually means that 30 percent of patient
encounters must be Medicaid patients. TeamLINKS MU2 is
a solution that can help you attest for the first two stages of
the six-year program, and we are committed to helping our
customers receive all incentive payments through the life of
the program. In the first year for Medicaid, EPs are required to
Adopt, Upgrade, or Implement (AUI) a certified EHR system to
qualify for an incentive payment of $21,250. If you act before
December 31st, you may still have time to “Adopt” and qualify
for the first year’s incentive in 2014. Contact us as soon as
possible if you think you may be eligible. If you want to move
forward with subsequent payment years, you need to install
and “meaningfully use” the certified solution to qualify for
incentive payments of $8,500 per year.
Those who have already attested for year-one or
year-two using another EHR system will find that TeamLINKS,
integrated with Dentrix, makes it much easier to track and
report the measures necessary to qualify and attest for the
incentive payments.
TeamLINKS Messenger and Becoming a Care Team “HUB”
Provider
When you send or receive referrals, how do you communicate
with the other providers and securely share patient data?
TeamLINKS Messenger (TLM) simplifies the communication
task of for you. Using TLM, providers can invite other dentists,

specialists, physicians, lab technicians, pharmacists, and other
health professionals to participate in their “Interdisciplinary
Care Team.” TeamLINKS makes it easy for providers to develop,
expand, and manage their own team of health care professionals.
TeamLINKS members invite other providers to connect
to their Care Team through “Messenger” requests. These
connections give them the ability to communicate and view
selected patient charts through the “HUB” and spoke concept
(Figure 1). Each invited Care Team member will then be able
to directly view and update a particular patient’s record. This
limited access allows collaboration only with the HUB provider
for the selected individual patients; however, the invitees can
economically become TeamLINKS Messenger™ members and
then be able to collaborate seamlessly with all other TeamLINKS
or TeamLINKS Messenger™ members as well as other providers
on an ad hoc basis (Figure 1).

TeamLINKS Messenger is a HIPAA-compliant, Secure,
Messaging System
If you are still using standard e-mail, fax, or other non-secure
forms of messaging to communicate personal health information
(PHI), you are playing with fire. These outdated methods that
may have been used in the past to share PHI are not secure and
not HIPAA-compliant. HIPAA penalties for breach of privacy and
electronic data security can be severe and costly.
TeamLINKS Messenger (TLM) is an integral part of the larger
EHR software but can also be subscribed to as a low-cost,
stand-alone tool for providers who do not have the full TLM
system. TLM is a HIPAA-compliant, secure messaging system
that uses your own email address and any Internet connection.
It provides a secure link for collaborative providers and
patients to access charts and exchange messages, files, X-rays,
photographs, and any file format that can be included in an
email message.
Full TeamLINKS EHR members can even send and receive
messages and files directly from the patient’s chart which then
automatically become part of the patient record.
For recipients who don’t yet have a TeamLINKS
subscription, a link is sent to them giving them the
opportunity to sign up for limited-time free access to
receive their message. After they are credentialed and
verified, recipients then have access to the message and
files as authorized. After discovering the convenience and
security of TeamLINKS Messenger, many providers find
that an upgrade to full TeamLINKS membership is both
convenient and cost-effective. And the peace of mind
gained from HIPAA compliance is priceless.
Summary
TeamLINKS gives you access to a proven, easy-to-use,
patient-centric, EHR solution. It provides tools for attesting
for the Meaningful Use incentive dollars and helps you
develop your own Interdisciplinary Care Team. Best of all, it
bolts right on to your Dentrix system. For more information,
contact USHealthRecord, Inc. at 866-625-7506 or by
sending email to info@ushealthrecord.com.

Figure 1 The TeamLINKS system.

The businesses listed here are not owned or controlled by Dentrix or Henry Schein and have created these descriptions of their
company, products and services themselves. Dentrix and Henry Schein make no independent assessment of the above descriptions
and consumers should contact these providers directly if seeking additional information about their products or services.
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Solution Guide
You already depend on Dentrix to make your practice more profitable and productive. Now, you can turn
Dentrix G5 into an even more powerful solution by adding trusted, fully integrated third-party applications
and capabilities to your digital dental office. The Dentrix Connected logo means the product has been
carefully developed, tested and certified to work with your Dentrix G5 platform. To see the full list of
Dentrix G5 Connected applications visit www.Dentrix.com/Integrated-products today.

Apteryx

Broadview

Citi

Dental Practice Solution

Network-based Business
Communication

Citi Health Card

www.apteryx.com

www.broadviewnet.com

www.healthcard.citicards.com

Make your practice more profitable with
OfficeSuite Dental the state-of-the-art
phone system that fully integrates with
Dentrix G5.

One click. One Solution. Patient financing
just got a lot easier. The Citi Health Card
program is now integrated within Dentrix
G5. Spend more time on patient care
and less money on your patient financing
program costs.

Demandforce

Dental Symphony

DEXIS

Patient Communication Solution

Dental Practice Solution

Digital Diagnostic Imaging

Demandforce works seamlessly with
Dentrix G5 software to automate online
and offline communications with existing
patients to improve in-office efficiencies.

Dental Symphony’s web-based
clinical software revolutionizes patient
management. Working alongside
Dentrix, Dental Symphony provides
innovative tools to practice easier,
safer and more efficiently.

DEXIS delivers innovative, high quality
digital imaging solutions to the dental
community. With its state-of-the art
sensor and easy-to-use imaging software,
Dexis provides numerous benefits to you,
your practice, and your patients.

Apteryx exceeds the expectations of its
customers by creating timely, innovative
and cost effective software solutions
that improve the profitability of the
clients’ businesses.

www.demandforce.com
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www.dentalsymphony.com

www.dexis.com

DocuFi

www.DocuFi.com

eDossea

www.edossea.com

Great Minds

www.greatminds.com

DocuFi

Intra-Office Communication

Dental Practice Solution

DocuFi™ is a Dentrix Connected partner
providing tools to capture and process
documents into electronic digital form.
ImageRamp™ is the most productive
document scanning solution for
Dentrix G5 users.

We are solely focused on the dental
profession and within the dental
profession on the secure, easy and
inexpensive transfer of your client’s
medical records from one office to
another. This is all we do.

Great Minds, Inc. provides easy to
use applications that provide valued
features and allow efficient and high
margin management of the office
and practice.

Lighthouse

LocalMed

Panda Perio

www.lh360.com

www.localmed.com

www.pandaperio.com

Patient Communication Solution

LocalMed

Periodontal Practice Solution

Lighthouse 360 is a comprehensive
automated patient communications system
designed exclusively for dentists. It uses
email, two-way text messaging, automated
phone calls, postcards and letters to
reach your patients.

LocalMed is a live online scheduling
platform that works with Dentrix through
the Connected Program to provide new
and existing patients online and mobile
scheduling access 24/7.

The complete clinical digital record
for Periodontal practices. Charting,
comparison reporting, treatment
planning, automated chart notes, and
much more. Save hours of admin time
and unify your front and back office.

Patient Activator

Practice Mojo

Practice Safeguard

www.patientactivator.com

www.practicemojo.com

www.practicesafeguard.com

Patient Communication Solution

Patient Communication Solution

Web-Based Fraud Monitoring

Patient Activator, part of Los Angelesbased 1-800-DENTIST®, is the leading
social media optimization and patient
communications service dedicated to
the dental profession.

PracticeMojo creates proven campaigns
that help dental practices recruit, retain
and reactivate patients automatically,
using email, text messages, automated
phone calls and mailed postcards.

A web-based financial monitoring tool for
Dentrix G5 users that deters fraud and
costly errors by alerting any device you
carry to unusual transactions in real time.
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RecordLinc

www.recordlinc.com

Reputation

www.reputation.com

Sesame

www.sesamecommunications.com

Patient Communication Solution

Patient Communication Solution

Patient Communication Solution

RecordLinc is the largest professional
network of dental professionals in
the world. Securely and easily send
electronic referrals, patient transfers, and
track treatment plans between dental
practices in a HIPAA compliant portal.

Reputation.com’s platform enables
dentists to see all their online reviews
in one space and use the platform’s
analytical tools to understand the
broad themes that emerge from
patient feedback.

Sesame Communications helps dental
and orthodontic practices harness the
power of the Internet to accelerate new
patient acquisition, build patient loyalty
and transform the patient experience.

Solutionreach

www.solutionreach.com

TeleVox

www.televox.com

Text2Floss

www.text2floss.com

Patient Communication Solution

Patient Communication Solution

Patient Education

Smile Reminder provides patient
engagement and communication solutions
for healthcare practices. Utilizing the
latest text, email, voice, video, web, and
social media tools to communicate
with customers.

TeleVox Software is a high tech
engagement communications company,
providing automated voice, email, text
and web solutions that activate positive
patient behaviors through the delivery
of a human touch.

An interactive educational tool meant
to help patients develop positive oral
hygiene habits by delivering oral health
information through the use of text
messaging and mobile technology.

Transparent Aluminum

U.S. Health Record

Yapi

www.transparentaluminumllc.com

www.teamlinks.com

www.yapicentral.com

YAPI
Dental Practice Solution

Intra-Office Communication

Dental Practice Solution

Transparent Aluminum is a company
focused on creating custom workable
solutions for practices to get the most
out of their Dentrix database.

Teamlinks EHR was created to foster
interdisciplinary collaboration on patient
health information with the goal of
connecting the health care team and
the patient.

Started as the first fully integrated
intra-office communication software,
YAPI has grown into a comprehensive
suite of innovative automation solutions
designed around unique needs of
dental practices.

The businesses listed here are not owned or controlled by Dentrix or Henry Schein and have created these descriptions of their company, products
and services themselves. Dentrix and Henry Schein make no independent assessment of the above descriptions and consumers should contact these
providers directly if seeking additional information about their products or services.
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OWN THE FUTURE™

Practice Planmeca

Planmeca Romexis® imaging software &
Dentrix practice management software

• Easy and instant access to all patient
information – from patient records to
X-ray images
• Patient data is automatically available
in Planmeca Romexis® after being
launched from Dentrix
• Seamless access of clinical
information ensures a smooth
workﬂow

www.planmecausa.com

PLANMECA USA INC. 100 North Gary Avenue, Suite A, Roselle, IL 60172, P.630.529.2300

Henry Schein Practice Solutions
1220 South 630 East, Suite 100
American Fork, Utah 84003

Unlock Your Full Digital Potential
Give Your Practice the Edge with Bundled eServices

Today’s digital technology has made it easier than ever to manage
your practice efficiently and profitably. Now Dentrix offers bundled
solution suites that pair the resources and support of traditional

Start Building Your Digital Future Today
Learn more about how the bundled eServices in

customer service plans with the digital convenience and time-

Dentrix Suites can boost your profits, improve your

saving features of Dentrix eServices.

care and make a lasting impression on every patient.

Engage patients, boost profits and enhance quality of care with
the Dentrix Suite that empowers you to make the most of your
digital technology. The Optimum Suite delivers our highest level
of resources, support and technology tools to help you work more
efficiently and better manage patient relationships.

©2014 Henry Schein, Inc.

Call 800.734.5561
www.Dentrix.com/Suites

